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C O N T E N T S

I recently took on a job that sounded simple at
first but quickly became complicated. The client
showed me a database form containing invoice-

like line-items and told me he wanted the following
capabilities and features designed into the database:

• Expandability without programming changes.
The client’s form contained 10 line-items. Each
line included a field for the date, item,
description, cost, quantity, and amount. He
wanted me to program the database so that he
could expand the form at some future date (add
more line-items) without having to modify the
programming!

• Bubble sorting. The client also wanted the
database programmed so that once the line-
items were entered, Q&A would sort them by
date and by cost within date. I was already
staggering as I asked him whether he wanted an

Loops, Arrays, and Bubble Sorting
Attention Q&A developers and power users: You can add variable arrays and loops
to your Q&A for DOS and Q&A for Windows database programs to automate tasks
you might have thought impossible. Here’s a feast of undocumented programming
potential that can make Q&A perform like the big boys.

By David E. Dvorin

ascending or descending sort. “Just make it
user-selectable,” he said!

Before I could hope to approach the problem in
Q&A, I had to think in terms of general
programming tools and concepts. I would need a
way to simulate variables and variable arrays and
perform loops—programming techniques not
directly supported by Q&A. In the end I was able to
accomplish the feat utilizing a little-known, but
powerful Q&A function, called @Field. I’ll show you
how @Field works and how you can use it to extend
programming functionality.

Variables and variable arrays
A variable is an area of memory where you store a
value that can be used in calculations and
operations. Though Q&A doesn’t support variables
in the pure sense, you can make variables out of
field values and store them in fields designed for the
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README.1ST
How do you program a multi-line-item database so
you can add more line-item fields to it later without
having to update the Program Spec? While you’re
chewing on that, here’s another requirement: the
program has to sort the line-items by date. It’s not
getting any easier, is it? Here’s the third requirement:
the program must accommodate a user-selectable
ascending or descending sort. Oh, and one more
little thing: you have to build in a progress meter to
display the program’s progress as it reorders the line-
items. Got it figured out yet? This is a gut-wrenching
task for any database, but you can do it all in Q&A
4.0 for DOS and Q&A for Windows—and in a single
Program Spec, to boot. Dave Dvorin shows you how
in an article that bristles with power-programming
ideas and techniques.

From the reader feedback we receive it’s clear
that many of you rely on Q&A to handle mailing list
management and automate regular mail merges with
letters, envelopes, and labels. Because I do a fair
amount of consulting along this line, and because of
increasingly stringent postal requirements, I decided
to look into postal bar coding to help speed my
clients’ mail along and even save them a few bucks
in postage. While working with a variety of
techniques and third-party utilities, I came up with
some solutions for Q&A for DOS and Q&A for
Windows I think you’ll find interesting. Whether you
mail a few pieces each month, or a few thousand,
you can make your mail travel faster and more
reliably—and cheaper than you might have thought.

Q&A User Group Event Set for Mid-September
Plan now to attend the National Q&A User Group’s
5th Annual Bash, September 15–17, 1995, just outside
Washington D.C. Registration is only $45 for The
Quick Answer subscribers (includes user group
membership). Hobnob with fellow Q&A enthusiasts,
meet and hear top developers, and attend solution-
oriented seminars and workshops. Bring your
nagging Q&A questions and brilliant solutions.
Spend three informative days with a fun-loving user
group. Call 301-963-6377 for a fax-back flier
containing the details.

Tom Marcellus
Editor
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purpose. Consider the following programming
statement:

If InvoiceDate < @Date - 60 then
   @Msg("This invoice is past due.")

In this example, InvoiceDate is being compared to
another date to determine if a message should be
displayed. The InvoiceDate field acts as a variable,
and the date it holds is the value assigned to that
variable.

A variable array is a series of variables. The
array allows you to refer to the series by one name
and use an index number to differentiate between
the variables included in the array. For example, a
commercial invoicing application would probably
create an array for an Amount column, where each
line-item’s Amount would be referred to as
Amount(1), Amount(2), Amount(3), and so forth.
You can apply the same concept to Q&A “variables”
by using fields named Amount1, Amount2,
Amount3, and so forth, instead.

Loop the loop
One way to put arrays to use is to employ looping—
a programming technique that repeats a series of
actions based on a condition you specify. Loops are
found in most programming languages. Loops, like
variables, are not directly supported in Q&A, but
you can simulate them. Consider the following
sample loop:

:  Initialize
   Counter = 0

:  Loop
   Counter = Counter + 1
   Amount(Counter) = Cost(Counter) *
      Quantity(Counter)

   If Counter > Max # of Transactions
      Then Goto BeyondLoop
      Else Goto Loop

This isn’t a valid Q&A program, but bear with me
for a moment.

At the start of the program, I initialize a variable
named Counter. In this example, Counter points to
the line number that’s a line-item.

In the Loop section of the program, I increment
Counter and calculate the line-item’s Amount by
multiplying its Cost and Quantity. Amount, Cost,
and Quantity are arrays. I’m using the same name to
reference related items, distinguishing them by the

value in Counter. For example, if Counter is 3, then
Amount(3) is Cost(3) multiplied by Quantity(3).

If Counter is greater than the maximum number
of transactions, then the loop is exited. On the other
hand, if Counter is less than or equal to the
maximum number of transactions, the program
loops back to increment Counter and calculate the
next line-item’s Amount.

In this sample loop logic, the loop condition is
based on whether Counter is greater than the
maximum number of transactions. The series of
statements increments Counter and calculates each
line-item’s Amount.

The logic looks great on paper, but how do you
turn it into valid Q&A programming code?

@Field to the rescue
The key to converting the loop logic into Q&A
programming code is the @Field function. @Field’s
syntax is @Field(x)—you can abbreviate it @(x)—
where x is a field name or field ID number. @Field
simply points to field x. Consider the following
examples:

1. Amount1 = Cost1 * Quantity1

2. @("Amount" + "1") = @("Cost" + "1") *
                       @("Quantity" + "1")

Both of these statements perform the same action.
They both say to store the product of the values in
the fields Cost1 and Quantity1 in the field named
Amount1. Example 1 is straightforward in that it
uses field names. Example 2 isn’t so obvious
because it uses expressions to build the field names
for the @Field functions. Although both programs
yield the same result, they differ in how they
reference fields. Example 1 is fixed, whereas
Example 2 is flexible.

In my project, I couldn’t program Example 1. If
someone later expanded the form by adding more
line-items, the Program Spec would need to be
updated accordingly. To achieve the goal of Program
Spec independence, I needed to come up with a way
of using the Example 2 technique in a loop. To see
how I did it, consider this third statement:

3. @("Amount" + @Str(Counter)) = @("Cost"
    + @Str(Counter)) * @("Quantity" + @Str(Counter))

In Example 3, I replaced the “1” in Example 2
with @Str(Counter). The result is the same, but now
the “1” is based on the variable Counter. Using the
value in the Counter field, I can make @Field return
Amount1, Amount2, Amount3, and so forth, and the
same for the Cost and Quantity fields, from line-
item to line-item. In other words, @Field’s ability to
accept an expression as its argument lets me

Loops, Arrays, Sorting
Continued from page 1
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simulate an array, and I can create a loop to
increment that expression. Converting the loop logic
I discussed earlier into a valid Q&A program is now
possible. Consider this routine:

<#1000:
Counter = 0;
Goto Loop

<#1010:
Counter = Counter + 1;
@("Amount" + @Str(Counter)) =
     @("Cost" + @Str(Counter)) * @("Quantity" +
     @Str(Counter));
If Counter > @Lookup(MaxTrans, 1)
   then Goto BeyondLoop
   else Goto Loop

In this program, Counter is field #1000 and
Loop is field #1010. BeyondLoop is a field elsewhere
on the form. Column 1 of the Lookup Table contains
the maximum number of line-items on the form,
and the Key value for the @Lookup command is
MaxTrans. If MaxTrans is set to 100, the loop will
perform the Amount = Cost * Quantity calculations
for line-items 1 through 100.

If the client decides to add more line items to
the form, he needs to update only these two areas:

1. At the Field Names Spec, assign names to the
new fields, following the proper naming
convention. In this case, the names are
Amountx, Costx, and Quantityx, where x is the
line-item number.

2. In the Lookup Table, update the value for the
new maximum number of line-items.

Now that you’ve seen how loops and arrays can
be simulated in a Q&A program, how can you put
them to use?

Bubble sorting
As its name suggests, a bubble sort is a sorting
technique. In Q&A, it’s applicable to sorting items
within a record. In my project, the client had a
database with several line-items, each with a Date,
Item, Description, Cost, Quantity, and Amount field.
He wanted these line-items sorted by date and cost,
and he wanted the option to select an ascending or
descending sort order.

To get moving in the right direction, I turned to
the bubble sort example on pages A-14 and A-15 of
the Q&A 4.0 Application Programming Tools Manual
and to the “Power Bubble Sorting” article in the
October 1992 issue of The Quick Answer. In this
article, Mike Bell discussed the following
shortcomings of the manual’s bubble sorting
technique, and how to overcome them:

• The technique sorts only numbers.
• Empty fields are placed first in the sort order.
• The sort can only be performed on one field.
• The technique sorts in descending order only.
• Slow performance

I wrote a new bubble sort routine. By
incorporating my variable array technique, I tackled
the first three issues. By creating loops, I addressed
the last two. But I also had the problem of a
multifield sort. I needed to sort by Date and then
Cost. If there were two transactions on the same day,
the Cost field had to determine the sort order. The
manual’s bubble sort technique wasn’t designed to
deal with this.

The bubble sort database
My bubble sort database (BBL_SORT.DTF) is shown
in Figures 1 and 2. Though BBL_SORT was created

Figure 1.  Page 1 of the BBL_SORT
database is for data entry.

Figure 2. Page 2 of the BBL_SORT database
contains read-only fields for the programming.
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in Q&A 4.0 for DOS, it works in Q&A for Windows
as well. Figure 1 shows page 1 of the layout. It looks
like a simple invoice with the Ship To and Bill To
area and the invoice body containing the line-items.
Figure 2 shows page 2 of the database, where the
additional fields required to perform the sorting are
located.

The key to BBL_SORT is the naming convention
for the line-item fields. The first line-item’s fields are
named Date1, Item1, Desc1, Cost1, Quantity1, and
Amount1. The second line-item’s fields have the
same names but with a “2” suffix, and so on for each
of the seven line-items.

Page 2 of the form (see Figure 2) includes what I
call transaction or Trans fields—one Trans field for
each line-item. These text fields follow the
convention for the line-item fields; that is, Trans1,
Trans2, Trans3, and so forth. They’re used to store
the concatenated line-item field values, which I’ll
describe later.

The remaining page 2 fields are described in
Table 1. All fields are formatted for text except
Counter and NumOfTrans, which are formatted NO
for numbers with zero decimal places. All the page 2
fields are read-only. The Sort field’s Navigation Spec
is >#1: Goto Sort, and the Restrict Spec for the
SortOrder field contains Ascending and Descending.

Table 1.  BBL_SORT’s page 2 fields.

Number Name Description

400 Counter Holds the current loop value.
410 NumOfTrans Contains the number of line-items on

the invoice.
420 BuildTrans Concatenates the line-items fields

for the Trans fields.
430 Sort First sort field.
440 Swap Second sort field.
450 SwapValue Third sort field.
460 Parse Parses the Trans fields into their line-

item values.
--- Position Assists in parsing the Trans fields.
--- Length Assists in parsing the Trans fields.

Programming
Listing 1 is BBL_SORT’s Program Spec. The field
names correspond to Table 1. An explanation of the
status messages displayed at each step during
program execution follows the programming:

Listing 1.  BBL_SORT Program Spec.

Sort Order
>#399:
@Msg("Initializing...");
Clear(AmountTotal, Counter, NumOfTrans, Swap,
      SwapValue);
Goto Counter

Counter
<#400:

Counter = 1;
NumOfTrans = 0;
AmountTotal = 0;
@Msg("Seeing how many transactions there are...");
Goto NumOfTrans;

NumOfTrans
<#410:
If Counter <= @Lookup("MaxTrans", 1) and
   @Len( @("Date" + @Str(Counter)) ) > 0 and
   @Len( @("Cost" + @Str(Counter)) ) > 0
   then {NumOfTrans = NumOfTrans + 1;
         Counter = Counter + 1;
         Goto NumOfTrans};
Counter = 1;
@Msg("Preparing for sort...");
Goto BuildTrans

BuildTrans
<#420:
If Counter < NumOfTrans + 1
   then
    {@("Amount" + @Str(Counter)) = @("Cost" +
     @Str(Counter)) * @("Qty"  + @Str(Counter));
     @("Trans" + @Str(Counter)) =
       "Date="   + @("Date"   + @Str(Counter)) +
       "Cost="   + @("Cost"   + @Str(Counter)) +
       "Item="   + @("Item"   + @Str(Counter)) +
       "Desc="   + @("Desc"   + @Str(Counter)) +
       "Qty="    + @("Qty"    + @Str(Counter)) +
       "Amount=" + @("Amount" + @Str(Counter));
     AmountTotal = AmountTotal + @("Amount"+
                   @Str(Counter));
     Clear(@("Date"   + @Str(Counter)),
           @("Item"   + @Str(Counter)),
           @("Desc"   + @Str(Counter)),
           @("Cost"   + @Str(Counter)),
           @("Qty"    + @Str(Counter)),
           @("Amount" + @Str(Counter)) );
         Counter = Counter + 1;
         Goto BuildTrans};
Counter = 1;
 Swap = "No";
@Msg("Sorting...");
Goto Sort

Sort
<#430:
If (@("Trans" + @Str(Counter)) > @("Trans" +
    @Str(Counter+1)) and SortOrder = "Ascending") or
    (@("Trans" + @Str(Counter)) < @("Trans" +
                 @Str(Counter+1))
   and SortOrder = "Descending")
   then Gosub Swap;
Gosub SwapValue;
If Swap <> "Completed"
   then  Goto Sort
   else {Counter = 1;
         @Msg("Inserting sorted transactions...");
         Goto Parse}

Swap
<#440:
Swap = "Yes";
SwapValue = @("Trans" + @Str(Counter));
@("Trans" + @Str(Counter)) = @("Trans" +
            @Str(Counter+1));
@("Trans" + @Str(Counter+1)) = SwapValue;
Return

SwapValue
<#450:
If Counter < NumOfTrans - 1
   then {Counter = Counter + 1;
         Return}
   else {If Swap = "Yes"
            then {Swap = "No";
                  Counter = 1;
                  Return}



© Marble Publications, Inc.6 The Quick Answer  ▲  June 1995

            else {Swap = "Completed";
                  Return } }

Parse
<#460:
If Counter < NumOfTrans + 1
   then
   {Position = @Instr(@("Trans" + @Str(Counter)),
                        "Date=") + @Len("Date=");
    Length   = @Instr(@("Trans" + @Str(Counter)),
                           "Cost=") - Position;
    @("Date" + @Str(Counter)) = @Mid(@("Trans" +
               @Str(Counter)), Position, Length);

    Position = @Instr(@("Trans" + @Str(Counter)),
                        "Item=") + @Len("Item=");
    Length   = @Instr(@("Trans" + @Str(Counter)),
                        "Desc=") - Position;
    @("Item" + @Str(Counter)) = @Mid(@("Trans" +
               @Str(Counter)), Position, Length);
    Position = @Instr(@("Trans" + @Str(Counter)),
                        "Desc=") + @Len("Desc=");
    Length   = @Instr(@("Trans" + @Str(Counter)),
                        "Qty=") - Position;
    @("Desc" + @Str(Counter)) = @Mid(@("Trans" +
               @Str(Counter)), Position, Length);
    Position = @Instr(@("Trans" + @Str(Counter)),
                        "Cost=") + @Len("Cost=");
    Length   = @Instr(@("Trans" + @Str(Counter)),
                        "Item=") - Position;
    @("Cost" + @Str(Counter)) = @Mid(@("Trans" +
               @Str(Counter)), Position, Length);
    Position = @Instr(@("Trans" + @Str(Counter)),
                        "Qty=") + @Len("Qty=");
    Length   = @Instr(@("Trans" + @Str(Counter)),
                        "Amount=") - Position;
    @("Qty" + @Str(Counter)) = @Mid(@("Trans" +
              @Str(Counter)), Position, Length);
    Position = @Instr(@("Trans" + @Str(Counter)),
                        "Amount=") + @Len("Amount=");
    Length   = @Len(  @("Trans" + @Str(Counter))) -
               Position + 1;
    @("Amount"  + @Str(Counter)) = @TN( @Mid(@("Trans" +
                  @Str(Counter)), Position, Length) );
    Counter = Counter + 1;
    Goto Parse};

@Msg("Sorting completed.");
Goto SortOrder

Status messages

Initializing
The Order and Counter field programs are executed,
initializing the variables.

Seeing how many transactions there are
The NumOfTrans program executes. Using a loop
and the MaxTrans value stored in the Lookup Table,
the program checks to see how many line-items
there are.

Preparing for sort
The BuildTrans program executes, building the
Trans fields by concatenating each line-item’s fields
(Date, Cost, Item, Description, and Amount). The
sorting to follow is performed on the Trans fields.

Sorting
The sort operation is performed by the programs in
Sort, Swap, and SwapValue. The Sort field program
provides the framework. It calls Swap to swap two
Trans fields when their sort order needs to be
determined. SwapValue determines what to do once
the swap has occurred; it either checks to see if
further sorting is required or exits the sort operation
and moves to Parse.

Inserting sorted transactions
The Parse program executes. The Trans fields have
been sorted, and their strings are now parsed into
the corresponding line-item fields on page 1 of the
form. (Parsing separates a string value into smaller
components—it’s the opposite of concatenation.)

Using BBB_SORT
Using BBL_SORT is easy. First, you fill in the header
section of the invoice, followed by the line-items.
Then, you press Alt-F7 from the SortOrder field to
choose the desired sort order. When you exit the
SortOrder field, the sorting begins. While the sorting
is occurring, BBL_SORT’s page 2 is displayed along
with the status messages at the bottom of the screen.
When the work is done, the program displays the
message “Sort completed . . .” and control is
returned to the SortOrder field on page 1.

[Curious about how well Dave’s database performed, I
ran a few quick tests on my 486DX2/50 PC. I found his
routine surprisingly nimble for the amount of work it
does, which includes calculating the extensions for the
Amount fields and totaling the invoice. The routine
processed seven line-items in four seconds whether I
chose an ascending or descending sort. The performance
you’ll get depends on your own system’s configuration
and the number of line-items processed —Ed.]

David Dvorin owns Phoenix Solutions of Hillsborough, New
Jersey, which specializes in tailoring off-the-shelf software for a
broad range of business needs. His bubble sort database is
available as presented in this article or custom configured. 908-
281-6272.
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For your programs that contain loops, you can keep
the user apprised of execution status by incorporating
a progress meter into the program. Similar to the built-
in progress meter Q&A displays when performing a
sort, your programmed meter can display a visual
representation of the status of program execution.

I use the @Msg function and the message line at
the bottom of the screen to display my progress
meter. The technique requires no additional fields but
involves some modification to the program containing
the loop. BBL_SORT includes three fields with loops:
NumOfTrans, BuildTrans, and Parse. I added my
progress meter routine to the loop in Parse. The
following program replaces the Parse program I
described earlier:

<#460:
If Counter < NumOfTrans + 1
   then {
 Position = @Instr(@("Trans" + @Str(Counter)),
                     "Date=") + @Len("Date=");
 Length   = @Instr(@("Trans" + @Str(Counter)),
                     "Cost=") - Position;
 @("Date" + @Str(Counter)) = @Mid(@("Trans" +
            @Str(Counter)), Position, Length);

 Position = @Instr(@("Trans" + @Str(Counter)),
                     "Item=") + @Len("Item=");
 Length   = @Instr(@("Trans" + @Str(Counter)),
                     "Desc=") - Position;
 @("Item" + @Str(Counter)) = @Mid(@("Trans" +
            @Str(Counter)), Position, Length);

 Position = @Instr(@("Trans" + @Str(Counter)),
                     "Desc=") + @Len("Desc=");
 Length   = @Instr(@("Trans" + @Str(Counter)),
                     "Qty=") - Position;
 @("Desc" + @Str(Counter)) = @Mid(@("Trans" +
            @Str(Counter)), Position, Length);

 Position = @Instr(@("Trans" + @Str(Counter)),
                     "Cost=") + @Len("Cost=");
 Length   = @Instr(@("Trans" + @Str(Counter)),
                     "Item=") - Position;
 @("Cost" + @Str(Counter)) = @Mid(@("Trans" +
            @Str(Counter)), Position, Length);

 Position = @Instr(@("Trans" + @Str(Counter)),
                     "Qty=") + @Len("Qty=");
 Length   = @Instr(@("Trans" + @Str(Counter)),
                     "Amount=") - Position;
 @("Qty" + @Str(Counter)) = @Mid(@("Trans" +
           @Str(Counter)), Position, Length);

 Position = @Instr(@("Trans" + @Str(Counter)),
                     "Amount=") + @Len("Amount=");
 Length   = @Len(  @("Trans" + @Str(Counter)))
                     - Position + 1;
 @("Amount"  + @Str(Counter)) = @TN( @Mid(@("Trans"
             + @Str(Counter)), Position, Length) );

 @Msg(@Text( @Int( Counter * 40 / NumOfTrans),
      @Chr(178)) + @Text(40 - @Int( Counter * 40
      / NumOfTrans), @Chr(177)) +
      " " + @Str(@Int((Counter * 100) /
NumOfTrans)) +
      "% - Working on #"+@Str(Counter)+" of " +
           @Str(NumOfTrans)+".");

 Counter = Counter + 1;
 Goto Parse
}
 else {@Msg(@Text(40, @Chr(178)) + " 100% -
                  Sort completed.");
 Goto SortOrder}

Using this program, a progress meter appears
when you exit the SortOrder field and the parsing
step begins. Figure 3 shows what it looks like.

At the heart of the progress meter is the @Text
function. @Text’s syntax, @Text(n,x), returns a text
value consisting of n copies of string x. For example,
@Text(3,"*") returns three asterisks.

The meter displays two characters, one for the
completed portion of the program, and another for the
uncompleted portion. Each portion has its own @Text
function. The length of the completed portion is
determined by the percentage completed (Period/
NumPeriods) multiplied by the meter width of 40. The
second portion’s length (the uncompleted portion) is
the remaining portion of the meter’s width, or the
difference between the meter width and the length of
the completed portion.

I use ASCII character 177—@Chr(177)—for the
completed portion, and ASCII character 178—
@Chr(178)—for the uncompleted portion. You can
use any two ASCII characters you want, but 177 and
178 provide a visibly attractive contrast.

I put a finishing touch on the meter by adding the
numerical percentage of completion and other status
information. (See Figure 3.) You can customize such
messages as you see fit, just keep in mind that
@Msg can display only up to 80 characters on the
message line.

Figure 3. The progress meter is constantly updated
by the executing program, keeping the user informed.

Add a Progress Meter to a Loop
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Edited by Dave Reid

Combine Fields
on a New Line

I use Q&A to store information about
patients in our hospital-based HMO.
Each record includes the patient’s
primary physician though that
physician’s services can be terminated

at any time and a new physician can take over. I
want to track the Effective Date and Termination
Date of all the primary physicians the patient has
used. Currently, I store this information in a
History field by inserting a few spaces and a line
of asterisks to separate each previous Physician,
Effective Date, and Termination Date. I’d like to
format the field so that each Physician, Effective
Date, and Termination Date automatically begins
on a new line in the History field.

Craig Landes, Batavia, Illinois

Figure 1 shows a sample Patient Information form
with a History field you can expand (by pressing F6)
to view the history of primary physicians. To have
Q&A automatically keep the History field up to
date, type the following program in the Termination
Date field in the Program Spec:

>If Termination Date <> "" Then
   {
   History = History + "
" + Physician + " - " + @Str(Effective Date)
+ " to " @Str(Termination Date);
   Clear(Physician, Effective Date,

      Termination Date);
   Goto Physician;
   }

The program executes when you type in a
Termination Date and exit the field. Q&A appends
the data to the end of the History field on the next
blank line because of the carriage return between
the set of double quotes:

History = History + "
" + . . .

When you type the program, include a carriage
return (press the Enter key) between the double
quotes. If you want a blank line between each entry,
you can add two carriage returns between the
double quotes. The dates Q&A returns to the
History field will be in Q&A’s internal format; for
example, 1995/06/22 for June 22, 1995. The balance
of the program clears the three fields and positions
the cursor in the Physician field, ready for you to
enter the new physician’s name and effective date.

[To make the History field easier to read, you can add a
programming step to further format the entries. For
example, you can add dot leaders between the physician’s
name and the dates to make the entries align like this:

Michael Roberts MD........1984/02/01 to 1985/03/18
William Sweet MD..........1985/03/18 to 1987/06/02
Jane Austin MD............1987/06/02 to 1991/07/12
Percival Westerhaven MD...1991/07/12 to 1994/12/28

Simply replace the dash along with its surrounding
quotes with the following expression:

@Text(@Width(Physician)-@Len(Physician),".")

This expression subtracts the length of the physician’s
name from the width of the field and fills the remaining
spaces with periods.—Ed.]

Sort Reports By
Derived Values

I print a report that lists our sales offices around
the country. I usually sort the report in Office
Number order. Recently, however, we decided to
sort first by State, and then by Office Number. I
know how to sort the State field (1,AS) and then
sort the Office Number within State (2,AS), but I
need to sort by the full state name rather than the
postal abbreviation. Can Q&A convert the state
abbreviations to the full state name for sorting
purposes only? I need to leave the state
abbreviations in the database for mailings.

Julie Waters, Belvidere, Illinois

Figure 1.  Sample Patient Information form with
History field expanded to display the chronological
history of primary physicians. When you enter a
termination date, the doctor becomes, as they say,
“history.” You can use this programming technique
to have Q&A maintain virtually any kind of history.
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You can get exactly what you need by creating a
simple Lookup Table for the database. Choose Edit
lookup table from the Programming menu. In the Key
column of the table, type in all the two-letter state
abbreviations and fill column 1 with the
corresponding state names, like this:

AK     Alaska
AL     Alabama
CA     California
OR     Oregon

The order of the entries doesn’t matter, as long as
you match the full state names with their correct
postal abbreviations. Next, redesign your report by
adding the following Derived Column:

Heading: State
Formula: @Lookup(State, 1)
Column Spec: 1,AS

In the Column/Sort Spec for the report, the Office
Number field should be 2,AS. (Unless you want to
include the State field elsewhere in your report, it
should contain no Column/Sort Spec codes.) When
you print the report, Q&A will use your Lookup
Table to convert each record’s state value (the postal
abbreviation) into the full state name, then sort by
these names. If a record includes a nonstandard
state abbreviation (one that doesn’t appear in the
Lookup Table), Q&A places it at the beginning of
the report. You can then edit the table or change the
pertinent record(s) and reprint the report.

Subtotal Time Values

I successfully used a suggestion in the February
1994 issue of The Quick Answer (page 9) that
explained how to track the time a student spends
in a class and display the result in an
hours:minutes format. I’d like to use this same
approach in a report; that is, I want to subtotal
these time values and display the results in the
same format.

Aryeh Sherman, Philadelphia, Pennsylvania

The solution you’re referring to included two fields:
Total Time and Display. The Total Time field stored
the number of minutes, and the Display field stored
the output formatted as you’ve indicated. For your
report, you’ll need to calculate the total for the Total
Time field and display the formatted result in
another column. You can use the same
programming logic that appeared in the February
1994 issue.

Create a report with the following Column/Sort
Spec:

Student Name: 1,AS
Display: 2
Total Time: 3,ST,I

Here, you’re subtotaling the Total Time field but
making it invisible because you want to display the
time in a custom format. Add the following derived
columns to format the time value and print it once
for each student:

Heading: Hours Part
Formula: @Str( @Int( @Total(#3, #1) / 60) ) + ":"
Column Spec: 5,I

Heading: Minutes Part
Formula: @Right("00"+ @Str( @Mod( @Total(#3, #1), 60)),
2)
Column Spec: 6,I

Heading: Total Time!In Classes
Formula: @Text(#1<>#50, @Str(#5) + @Str(#6) )
Column Spec: 7

Heading: Delayed copy of Student Name
Formula: #1
Column Spec: 50,I

Columns 5 and 6 calculate and format the hours and
minutes for each subtotal. (Column 5 divides the
subtotal by 60 and returns the integer portion, while
column 6 returns the remainder.) Column 7
combines the two parts and, in conjunction with
column 50, forces the value to print only once for
each student.

Control Your Alternate
Programs

I have a large Q&A 4.0 macro file. Though I’ve
been told not to use Ctrl-key combinations for my
macros, I’ve recently started using them because I
ran out of Alt-key combinations. I’ve encountered
only one problem: I can’t get Q&A to recognize
them for alternate Main menu programs. When I
try to use them to launch alternate programs, I
receive messages such as “Alternate program: ctrlc
cannot be found.” What am I doing wrong?

Walt Weaver, Lincoln, Nebraska

Q&A doesn’t allow macros with Ctrl-key
combinations to be used as alternate program
macros. Only Alt-key combinations, such as Alt-A or
Alt-D can be used. Therefore, any macro you want
to run from the Main menu must be defined with an
Alt-key combination. I should point out that Q&A
doesn’t require you to assign key identifiers to your
macros. You can assign names to them instead and
run them from custom menus or the List of Macros.
You can display the List of Macros from anywhere
in Q&A by pressing Alt-F2.
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Change Your Default
Font in Q&A Write

Is it possible to change the default font in Q&A
Write for Windows? I’d like my default font to be
10-point Arial, not 12-point Times New Roman.

Quentin May, Mannheim, Germany

Start Q&A Write so you have a new, untitled
document onscreen. From the Edit menu, choose
Select. Then, from the submenu, choose All. Pull
down the list of fonts and choose Arial. Pull down
the list of point sizes and choose 10 point. Then, pull
down the File menu and choose Save As. In the Save
As dialog box, pull down the Save Files of Type box
and select Q&A Write Template. Enter a file name,
such as BLANK.QWT, and click OK. Pull down the
File menu, choose Preferences, and then choose File
from the submenu. In the File Preferences dialog
box, click the Select Default Document button.

Again, change the List Files of Type box to Q&A
Write Template, select the file named BLANK.QWT,
and click OK. Now, when you start a new
document, the default font will be 10-point Arial.
You can change other default settings for
BLANK.QWT, such as its page dimensions. If you
do, remember to resave the file as a template.

Dave Reid is a Symantec senior support analyst providing
second-level assistance to the technical support reps. He’s also
the coauthor of The Q&A 4.0 Wiley Command Reference,
published by John Wiley and Sons and works as an independent
Q&A consultant. PO Box 12083, Eugene, OR 97440.

Have a nagging question? Send it to @Help,
The Quick Answer , Marble Publications Inc.,
PO Box 9034, Gaithersburg, MD 20898-9034
or fax to 301-424-1658 . When writing, please
include your name, address, and phone
number, along with your Q&A version number
(and whether DOS or Windows) and a detailed
description of the problem. We will publish
those questions we feel are of general reader
interest; individual responses are not possible.

Avoid Risk to Your Macro File
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If you’re running Q&A for DOS in
Windows, don’t attempt to run a Q&A
macro containing commands that invoke
Windows-specific actions, such as
displaying the Task List (Ctrl-Esc),
switching to another program (Alt-Tab),
or running Q&A in a Window (Alt-

Spacebar or Alt-Enter). If you do, you can blow
your macro file clean out of existence.

Tom Marcellus

Better Envelope Printing

Q&A for DOS’s envelope printing
features don’t work well with my laser
printer, even with added printer control
codes. I’ve found a better way. With my
letter displayed, I save it with Shift-F8,
move the cursor to the beginning of the
name and address block, and run a macro
that performs the following steps:

1. Block deletes the address block.

2. “Presses” Esc and gets my landscape formatted
document named ENVELOPE.DOC, in which the
left margin is set half way across the page, and the
cursor is positioned half way down the page.

4. Answers Yes to abandon changes to the previous
document.

5. “Presses” Shift-F7 to restore the deleted address
block at the optimum position for the envelope.

6. Prints the document to the landscape printer (I place
an envelope in the feed tray).

7. Exits ENVELOPE.DOC without saving it, and
returns to the Write menu.

I use this macro with every letter I mail.

Roger Skidmore, Isle of Wight, Great Britain.
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Easy-to-Use Utilities Make Your Mail
Look Better and Travel Faster
Whether you mail a few or a few hundred pieces a week, these utilities work with
your Q&A database to print envelopes and labels complete with postal bar codes.

Reviewed by Tom Marcellus

YOU want good-looking, accurately addressed
envelopes and mailing labels. And if you can
save on postage by adding postal bar codes

to your mailing pieces, so much the better. I
discovered two Windows add-ons—and a DOS bar
coding utility—that expand your options for
printing envelopes and labels.

A special font included with POSTools (see the
“Resources” sidebar) prints approved Postnet bar
codes on your Q&A for Windows output. Another
utility, Dazzle Plus, helps you quickly design
stunning envelopes and mailing labels. And if you
have a modem, you can use its Dial-A-Zip feature to
obtain address corrections and delivery point ZIP
codes from post office computers. If you use Q&A
for DOS and have Windows installed on your PC,
you can still use Dazzle Plus. If you don’t have
Windows, you can use a terminate-and-stay-
resident program (TSR) called BAR_LITE to print
postal bar codes on your output. I’ll show you how
to get the most from these utilities with both
editions of Q&A.

What you need
Postal bar codes on envelopes and labels help speed
mail along, ensure accurate delivery, and can earn
bulk mail discounts. Getting the nine-digit ZIP+4 or
11-digit delivery point ZIP codes is the first step. If
you have a modem, Dazzle Plus’ Dial-A-Zip can do
this for you. Another option is to use the post
office’s address correction service. You give the post
office an ASCII export file of your addresses, and it
returns the file with address corrections and
delivery point ZIP codes. Other options include
commercial address correction services and systems.

Once you have the extended ZIP codes in your
database, it’s just a matter of configuring Q&A and
the utilities to print the bar codes on your mailing
pieces.

Postnet bar code font
Azalea Software’s POSTools creates bar code strings
from ZIP codes and comes with a Windows
TrueType font you can use to transform those

strings to approved Postnet bar codes. Because you
can write a Q&A program to create the bar code
strings more efficiently, all you really need from
POSTools’ is the bar code font. If you’re on
CompuServe, you can download it in a file named
ZIPBAR.ZIP. (You can find it in the DTP and ZiffNet
file libraries.) The unzipped file contains
ZIPCODEB.TTF. Add this file to Windows’ font list
via the Control Panel, and the ZipCodeBarCodeTT
font will appear on Q&A’s font list.

Calculate the ZIP code check digit
A Postnet bar code includes start and stop bars and
bars for the ZIP code’s digits and check digit. To
calculate the check digit, add the ZIP code digits,
then determine what number must be added to that
total to make the next multiple of 10. Marble
Publication’s nine-digit ZIP code is 20898-9034. The
sum of the digits is 43, the next multiple of 10 is 50,
so subtract 43 from 50 to get the check digit of 7.

The ZipCodeBarCodeTT font works with a
string value in the format s+ZIP code+check digit+s.
(Marble’s ZIP code string would be s2089890347s.)
When you apply the font to a such a string, it’s
transformed into the corresponding Postnet bar
code.

Let Q&A do the work
Q&A can calculate the ZIP code’s check digit, create
the bar code string value, and place it in a field. You
simply apply the bar code font to the field and, voilá,
its value is transformed into the Postnet bar code.
I’ll demonstrate using CONTACT.DTF, a ready-to-
use database that comes with Q&A for Windows.
CONTACT includes a custom Rolodex form (see
Figure 1) in addition to a Master form (see Figure 3).

Start by adding a new text field named Barcode
to the CONTACT database, then redesign the
Rolodex form, centering the Barcode field under the
Rolodex card as shown in Figure 1. Size the field to
three inches in length, and remove the label so only
the field remains. Apply the 16-point
ZipCodeBarcodeTT font to it, and a series of boxes
will appear in the field.
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You can add the Barcode field just to the Master
form. (See Figure 3.) This way, the field will be
available for use in mail merges without upsetting
your custom form’s appearance. Also, you don’t
have to apply the font to the field on the form (the
Figure 3 Barcode field contains only the string
value)—you can apply it to the merge field in your
template.

You can now write the program that calculates
the check digit and creates the bar code string value.
Type the following program in your Zip Code field:

> Zip Code = @Num(Zip Code);
Barcode = @TN(@Left(Zip Code,1))+

@TN(@Mid(Zip Code,2,1)) +
@TN(@Mid(Zip Code,3,1)) +
@TN(@Mid(Zip Code,4,1)) +
@TN(@Mid(Zip Code,5,1)) +
@TN(@Mid(Zip Code,6,1)) +
@TN(@Mid(Zip Code,7,1)) +
@TN(@Mid(Zip Code,8,1)) +
@TN(@Mid(Zip Code,9,1)) +
@TN(@Mid(Zip Code,10,1))+
@TN(@Mid(Zip Code,11,1));

Barcode=@Right(100-Barcode,1);
Barcode = "s" + Zip Code+Barcode + "s";
If @Len(Zip Code) > 5 then

Zip Code = @Left(Zip Code, 5) + "-"  +
@Mid(Zip Code,6,6)

The program executes when you exit the Zip
Code field. It strips the dash from the ZIP code, and
calculates the check digit by adding the ZIP code
digits and subtracting the rightmost digit of the sum
from 100. It then creates the bar code string for the
Barcode field and restores the dash.

You can also turn this program into a Mass
Update Spec, so all your address records are bar
code ready.

To test your program, change to Add/Edit,
move to the Zip Code field, type in a Zip+4 or 11-

digit ZIP code, and press Tab, If you’ve used the bar
code font for the Barcode field, the bar code should
appear just below the Rolodex form; otherwise, just
the string value will appear. You can now add the
Barcode field to your merge letter, envelope, or
mailing label.

POSTools also comes with a PostScript bar code
font, as well as several .EPS and .TIF files containing
Facing Identification Marks (FIMs) that you can
include on your bar coded envelopes.

Dazzle Plus for dazzling envelopes—and more
Dazzle Plus from Envelope Manager Software helps
you create gorgeous envelopes and labels, but does
a whole lot more. (See Figure 2.) What makes this
Windows program an outstanding value is it’s
powerful Dial-A-Zip feature. With a modem, you
can have Dial-A-Zip automatically call a post office
computer to obtain online address corrections and
11-digit delivery point ZIP codes for one or 100 or
more addresses.

Make Dazzle Plus work with Q&A
To pass the address in the Q&A for Windows record
you’re viewing to Dazzle Plus, you can use
Windows’ Clipboard or an export file. The export
file option is mandatory if you’re using Q&A for
DOS or passing multiple addresses.

The tricky part about using the Clipboard is
copying the whole address (for example, name,
street, city, state, and ZIP code) as a single block.
One way to do this is to have Q&A copy the various
address fields to a multiline field, even if only
temporarily. You can then pass the whole address to
Dazzle Plus via the Clipboard.

Follow the installation instructions that come
with Dazzle Plus and set it to run minimized. This
way, when you start the program, it won’t display

Figure 1.  The Rolodex form that comes with Q&A for
Windows. Here, the ZipCodeBarcodeTT font (in 16
points) has been applied to the Barcode field.

Figure 2.  A sample Dazzle Plus envelope layout.
You can add graphics, fonts, and position any
element where you want it.
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but will be available to switch to from Q&A. You
can add Dazzle Plus to your Windows StartUp
group, so it will start minimized when you start
Windows. Your Windows manual tells you how to
do this.

Next, consult the documentation that comes
with Dazzle Plus to specify your preferences and
create your envelope layout. Don’t forget to select
your printer and modem (if you have one), along
with the post office you want Dial-A-Zip to call.
When you’ve got everything working, save the
layout and switch to Q&A.

Add the combination address field to your Q&A
database. Name it Address Block or something
similar. Place it on the form you use to display your
address information and size it to about 2-1/2
inches wide and high enough for a five- or six-line
address block. (See Figure 3.)

The following program for the Zip Code field
copies the address fields to your new multiline field.
It assumes your fields are named First, Last, Title,
Company, Address, City, State, and Zip Code. To
include more or fewer fields, or if your field names
are different, modify the program accordingly:

> Address Block = First +" "+ Last+"
"+Title+"
"+Company Name+"
"+Street Address+"
"+City+" "+State+" "+Zip Code

When typing the program, press Ctrl-Enter at
the end of each line, as shown, so that lines 1
through 4 end with a double quote, and lines 2
through 5 begin with a double quote. This inserts a

carriage return between the sets of double quotes so
the address data Q&A copies to the Address Block
field winds up in the proper format. (See Figure 3.)
You can also adapt this program to mass update the
database.

Copy an address to Dazzle Plus
To pass the address in the record you’re viewing to
Dazzle Plus, move to the Address Block field, and
highlight the address by dragging the mouse over it.
Click on the Edit menu, and select Copy to copy the
address to the Clipboard. (You can optionally press
Ctrl-Shift-End to highlight the address, and Ctrl-C
to copy it to the Clipboard.)

Switch to Dazzle Plus, and your default Dazzle
Plus envelope should appear with the Clipboard
address already inserted. Click on the Print button
to print the envelope, or use Dial-A-Zip to link up
with the post office for an address correction.

Print envelopes for multiple addressees
Dazzle Plus accepts a comma-delimited ASCII file.
This means you can pass a file of addresses from
Q&A for Windows or Q&A for DOS to Dazzle Plus
to process with Dial-A-Zip, to batch-print envelopes
or labels, or to do both.

Create an export file in Q&A for Windows by
choosing Export from the File menu. Specify the
fields to be included, and choose the default
comma-delimited (with quotes around values)
export format. (See Figure 4.) Attach your Retrieve
and Sort Specs, run the export, and save the file to
DAZZLE.TXT.

Switch to Dazzle Plus, click on its File menu,
and choose Print List from File. Select the
DAZZLE.TXT export file from the file list, and the
Delimited File Options dialog box will appear. (See
Figure 5.) Map the fields in your export file to

Figure 3. The redesigned Master CONTACT.DBF
form. Your program creates a multiline address block
from the name and address fields, making it easy to
pass the address to Dazzle Plus via the Clipboard.
This form also includes Delivery Point and Carrier
Route fields.

Figure 4. Q&A for Windows’ Export dialog box and
Text Export Options dialog box filled out to create a
DAZZLE.TXT export file.
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Dazzle Plus’ default fields. (You only have to do this
the first time as long as your export file always
contains the same fields in the same order.) Click
OK to print. Dazzle Plus will save your mapping
specification for future use.

Follow the same steps to run Dial-A-Zip on
your Q&A export file, except choose Dial-A-Zip List
from the Dial-A-Zip pull-down menu. Once the
addresses have been corrected, you can print the
envelopes (or labels) using the Print List command.

Getting address corrections into your database
When Dial-A-Zip obtains an address correction, it
displays the corrected address on the envelope. You
can double-click on the address block, highlight the
nine-digit ZIP code, and press Ctrl-C to copy it to
the Clipboard. You can then switch back to Q&A
and paste it into your Zip Code field.

However, there’s an advantage to passing
addresses (even a single address) to Dazzle Plus via
an export file. When you run Dial-A-Zip on the file,
it updates the file with any address corrections,
adds the ZIP+4 ZIP codes, and optionally the two-
digit delivery point codes. This provides you with
the means to update the corresponding record(s) in
your Q&A database with the full 11-digit delivery
point ZIP code(s).

Here’s a portion of a comma-delimited Q&A
export file with the last field (Delivery Point) empty:

"C1534","Tom","Bernstein","25642 Gator Tooth Ln",
"Jaketown","FL","55222",""
"C1213","Annette","Carr","25396 Main St",
"Sacramento","CA","96858",""
"C3244","Tracey","Michaels","333 Santa Cruz Ave",
"Sunnyvale","CA","94566",""

Here’s the same file after Dial-A-Zip has
updated it with ZIP+4 and delivery point codes:

"C1534","Tom","Bernstein","25642 Gator Tooth Ln",
"Jakestown","FL","55222-2433","42"
"C1213","Annette","Carr","25396 Main St",
"Sacramento","CA","96858-2334","96"
"C3244","Tracey","Michaels","333 Santa Cruz Ave",
"Sunnyvale","CA","94566-3211","33"

By including the customer ID and Delivery
Point fields in your Q&A export file, you can import
the updated ASCII file back into Q&A to update
your addresses. This way, you won’t have to run
Dial-A-Zip on these addresses the next time you
mail to them.

Make your system sing
If you’re eager to integrate Q&A with Dazzle Plus
and use full delivery point ZIP codes and bar codes,
you can configure Q&A to do most of the work. This
section tells you how. The techniques described are
for Q&A for Windows, but you can adapt them to
Q&A for DOS.

Single addresses
For single addresses, add two fields to your
database. Name the first one Delivery Point and the
second one Temp. Program Temp with the
@Number command, and set it to execute on-
record-entry. This way, any record you activate will
be assigned the highest @Number.

Next, create and save a Retrieve Spec that
includes Max in the Temp field. Then create and
save a comma-delimited (with quotes around text)
Export Spec. Include in the Spec your address fields,
along with a unique ID field (such as Account
Number or Customer ID) and the Delivery Point
field. (See Figure 4.) Save the Export Spec to Export
to Dazzle.txt, run the export, and save the export file
to DAZZLE.TXT.

To pass an address to Dazzle Plus, retrieve the
pertinent record and click on a field to increment its
@Number. From the File menu, choose Export.
Select your saved Export to Dazzle spec, attach your
Max Retrieve Spec, and click on Export. Choose
DAZZLE.TXT as the export file name, and click on
Yes to overwrite it. For what to do next, see the
“Using Export Files in Dazzle Plus” and “Passing
Corrected Addresses back to Q&A” sections later in
this article.

Multiple addresses
To export a group of Q&A addresses to Dazzle Plus,
first Retrieve the records you want to include. Then
from the File menu, choose Export, select the Export
to Dazzle.txt Export Spec you created earlier, and
attach the Last Run Retrieve Spec. The records you
just retrieved will be included in the export file.
Choose DAZZLE.TXT as the export file name, and
click on Yes to overwrite it.

Figure 5.  Use Dazzle Plus’ Delimited File Options
dialog box to map the ASCII export file’s fields to
Dazzle Plus’ fields.
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Using export files in Dazzle Plus
Pull down the Dial-A-Zip menu, and select Dial-A-
Zip List from File. Select the DAZZLE.TXT export
file, and click OK to display the Delimited File
Options dialog box. (See Figure 5.) Map the fields in
the ASCII export file to Dazzle Plus’ fields (if they’re
not already correctly mapped). Be sure to map the
Delivery Point field, but don’t map the field that
contains the unique record ID. Click OK, and Dazzle
Plus will invoke Dial-A-Zip and dial the post office
computer.

The Dial-A-Zip process updates your
DAZZLE.TXT export file, adding the ZIP+4 and
delivery point code. You can now choose Print List
from the File menu to print envelopes or labels for
the updated addresses in DAZZLE.TXT.

Pass corrected addresses back to Q&A
To import the updated DAZZLE.TXT file back into
Q&A to update your address records, you’ll need a
supplementary database. Create a database named
DAZZLE.DTF, with the same fields in the same
order as your DAZZLE.TXT export file. Make the
Account Number or Customer ID field Speedy.

When the database is ready, select Import from
the File menu, and choose DAZZLE.TXT from the
file list. At the Import dialog box, click on the Add
button repeatedly to map the fields in DAZZLE.TXT
to the matching fields in DAZZLE.DTF, then Click
OK to run the import.

Update your main address database
You can now mass update your main database using
XLookups to DAZZLE.DTF. Run the same Retrieve
Spec you used to create your most recent export file,
then create, save, and run the following Update
Spec, substituting your own field names for those
shown:

#1: XLookup("Dazzle",Account Number,"
    Account Number", "Zip Code",Zip Code,"
    Delivery Point",Delivery Point)

You can now run a Mass Delete on the
DAZZLE.DTF database, or keep adding to it with
each export and subsequent import.

Printing in Q&A for Windows
Once your address database contains the ZIP+4 and
delivery point codes, you can use POSTools’
ZipCodeBarcodeTT font to create complete delivery
point bar codes for the envelopes, letters, or labels
you print in Q&A. You can use the Zip Code
program shown earlier to calculate the check digit
and create the bar code string. Modify the program
as follows:

+ @TN(@Left(Delivery Point,1))
+ @TN(@Mid(Delivery Point,2,1));
Barcode = "s" + Zip Code + Delivery Point +
          Barcode + "s"

Bar code solutions for Q&A for DOS
If you have Windows installed on your PC, you can
use Dazzle Plus to design and print your envelopes
and labels and run Dial-A-Zip on your Q&A for
DOS addresses. You can then return the corrected
addresses and ZIP codes to your Q&A for DOS
database as I described earlier.

You can record Q&A macros to automate the
export, import, and mass update on your address
database. For example, you can run the macro that
creates your ASCII export file (with a pause at the
Retrieve Spec to select the records to include). Then,
you can exit Q&A, start Windows and Dazzle Plus,
and run Dial-A-Zip on your export file (optionally
printing your envelopes or labels). Finally, you can
exit Windows, restart Q&A, and run the macro that
imports the updated ASCII file into your
supplementary database, followed by the mass
update on your main address file.

You can automate the process even further. As
its final step, the Q&A macro that creates the export
file can run a DOS batch file (as an alternate program)
such as the following one (WIN_DAZL.BAT) that
starts Windows and Dazzle Plus, and loads your
DAZZLE.TXT export file for Dial-A-Zip processing
(you can adapt it for printing):

cd\windows
win recorder -h^a dazzle.rec

When you exit Windows, Q&A automatically
restarts, and you can run the macro that imports the
updated ASCII file into your supplementary
database then mass updates your address database.

A Windows Recorder macro (see your Windows
manual) automates the Windows part of the task.
Record a macro with a Ctrl-A shortcut key (that’s
the ^a in the batch file—you can use another
shortcut key) and save it to a Recorder macro file
named DAZZLE.REC (specified in the batch file.)
Here are the keystrokes to record in the macro:

Ctrl-Esc    Three preliminary commands are
P           required to run the start-up macro.
Enter
Alt-F       Pulls down the File menu.
R           Selects the Run command.
[file spec] Types the path to Dazzle Plus,
            such as c:\dazzle\dazzle.exe.
Enter       Starts Dazzle Plus.
Alt-D       Pulls down the Dial-A-Zip menu.
D           Selects Dial-A-Zip List.
F           Selects from File.
The above three steps can be modified to print
envelopes or labels.
[file spec] Types the path and name of the export
            file, such as c:\qawin\dazzle.txt.
Enter       Displays the Delimited File Options
            dialog box.
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Though it takes a bit of doing to set this up, the
reward is getting lots of work done with just a few
keystrokes.

Even without Dazzle Plus, you can still print
Postnet bar codes on your Q&A for DOS output
using a memory resident bar coding utility such as
BAR_LITE. (See the Resources sidebar.) BAR_LITE
reads the data stream passed to your printer. When
it spots a ZIP+4 ZIP code, it adds the
delivery point code (the last two digits
of the street or box number) and prints
the matching Postnet bar code on the
letter, label, or envelope. BAR_LITE
runs in conventional or extended
memory, it’s customizable, and you
can load it only when you’re ready to
print.

If you don’t want to use a TSR,
Architext sells a downloadable PCL
(HP LaserJet and compatibles) Postnet
bar code soft font. The font comes in
portrait and landscape orientations,
and includes a handy download utility.
You can use Q&A’s QAFONT.EXE
utility to append the font’s description
to your Q&A font description file.

Architext’s bar code font operates
on a string value the same way as
POSTool’s ZipCodeBarcode font,
except that you use “(” to denote the

start and stop bars. Program your database to
calculate the ZIP code check digit and create the bar
code string in the format (2089890347(. You can then
apply the font to that merge field on your mailing
label. Architext also offers the font on a plug-in font
cartridge.

Tom Marcellus is editor of The Quick Answer and author of PC
World Q&A Bible, published by IDG Books.

Resources

Architext
121 Interpark Blvd., Suite 208
San Antonio, TX 78216-1808
210-490-2240
Fax 210-490-2242
$150

BAR_LITE
Group 1 Software
4200 Parliament Pl., Suite 600
Lanham, MD 20706-1844
800-368-5806
Fax 301-918-0747
$9.95 through July 31, 1995

Dazzle Plus
Envelope Manager Software
247 High St.
Palo Alto, CA 94301-1041
415-321-2640
Fax 415-321-0356
$39.95

POSTools
Azalea Software
PO Box 16745
Seattle, WA 98116-0745
800-482-7638
Fax 206-937-5919
$49

Second-Class
Postage Pending at

Rockville, MD

M A R B L EM A R B L E
P U B L I C A T I O N S
M A R B L E

PO Box 9034
Gaithersburg, MD 20898-9034


